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RESUMO 

 

A insuficiência renal crônica representa um impacto à nível individual e coletivo 

que se traduz no sofrimento que a doença traz aos pacientes e no aumento gradativo 

dos gastos tanto com os métodos de diálise quanto com as doenças associadas à 

esse público. Algumas tecnologias podem ser extremamente úteis na tomada de 

decisões na área da saúde. Uma dessas tecnologias é a rede bayesiana, que tem 

como um dos exemplos a capacidade de auxiliar, ainda durante a triagem, na melhor 

escolha do tipo de acesso vascular do paciente com insuficiência renal grave, entre 

outras situações. O objetivo deste trabalho foi analisar as possíveis relações de 

causalidade, utilizando inferências probabilísticas, entre os fatores relacionados para 

estipular as principais causas de óbito em pacientes com insuficiência renal grave. A 

metodologia baseou-se na análise de prontuários de 121 pacientes fazendo uso de 

inteligência artificial, as redes bayesianas, a fim de estabelecer uma relação de 

probabilidade condicional entre as variáveis dos pacientes com insuficiência renal 

grave. Através do estudo foi possível identificar que a escolha do tipo acesso venoso 

fístula arteriovenosa (FAV), sempre que possível deve ser priorizada, pois demonstra 

ser uma estratégia fundamental para a manutenção no número de óbitos dos centros 

de hemodiálise, assim como manter cuidado redobrado quando ao tabagismo entre 

os pacientes, pois se apresentou como grande fator de risco, tanto individual quanto 

somado a outras variáveis, no grupo de pacientes em questão. A análise, utilizando-

se das redes bayesianas, é de grande valia para o grupo pertencente ao estudo, visto 

a oportunidade de identificar a evolução da insuficiência renal e consequentemente 

promover a redução no número de óbitos. E também é de grande proveito para os 

profissionais da saúde, auxiliando principalmente no Suporte à Decisão Clínica (SDC). 

 

 Palavras-chave: Hemodiálise. Diálise. Variáveis. Insuficiência renal. Redes 

bayesianas. Acesso vascular. 

 

 

 

 

 



 
 

 

ABSTRACT 

 

Chronic renal failure represents an impact at the individual and collective level that 

translates into the suffering that the disease brings to patients and the gradual increase 

in expenses both with dialysis methods and with the diseases associated with this 

public. Some technologies can be extremely useful in decision-making in healthcare. 

One of these technologies is the Bayesian network, which has, as an example, the 

ability to help, even during screening, in the best choice of vascular access for patients 

with severe renal failure, among other situations. The objective of this study was to 

analyze the possible causal relationships, using probabilistic inferences, between the 

related factors to stipulate the main causes of death in patients with severe renal failure. 

The methodology was based on the analysis of medical records of 121 patients using 

artificial intelligence, Bayesian networks, in order to establish a conditional probability 

relationship between the variables of patients with severe renal failure. Through the 

study, it was possible to identify that the choice of venous access type arteriovenous 

fistula (AVF), whenever possible, should be prioritized, as it proves to be a fundamental 

strategy for maintaining the number of deaths in hemodialysis centers, as well as 

maintaining extra care when to smoking among patients, as it was a major risk factor, 

both individually and in addition to other variables, in the group of patients in question. 

The analysis, using Bayesian networks, is of great value for the group belonging to the 

study, given the opportunity to identify the evolution of renal failure and consequently 

promote a reduction in the number of deaths. And it is also of great benefit to health 

professionals, mainly assisting in Clinical Decision Support (CDS). 

 

Keywords: Hemodialysis. Dialysis. Variables. Renal insufficiency. Bayesian networks. 

Vascular access. 

 

 

 

 

 

 

 



 
 

 

DIVULGAÇÃO E TRANSFERÊNCIA DE CONHECIMENTO 

 

Através do estudo foi possível identificar que a melhor escolha para o paciente 

que tem doença grave do rim é o uso de uma ligação realizada através de cirurgia 

entre a artéria e a veia do paciente, para aumentar a grossura da veia, permitindo 

vários furos na veia para fazer a hemodiálise de modo mais seguro e diminuindo as 

chances de infecção que podem levar a morte. 

Também se identificou que é muito importante que os pacientes que fazem 

hemodiálise que não façam uso de nenhum tipo de cigarro, pois isso aumenta a 

chance de morte do paciente. 
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1 INTRODUÇÃO 

 

A Doença Renal Crônica (DRC) representa um impacto à nível individual e 

coletivo que se traduz no sofrimento que a doença traz aos pacientes e no aumento 

gradativo dos gastos tanto dos métodos de diálise quanto com as doenças associadas 

a esse público (SECRETARIA DE SAÚDE DE MATO GROSSO DO SUL, 2011). 

Houve um aumento drástico, no mundo inteiro, no número de pessoas com 

insuficiência renal crônica nos últimos anos, no Brasil também. Alguns apelidaram a 

doença de "a epidemia nova do século XXI". Enfrentá-la significa desenvolver modelos 

de práticas que favoreçam e priorizem abordagens individuais e coletivas e reduzam 

a morbidade e mortalidade da DRC. É necessário refletir sobre estratégias que 

possam ajudar a melhorar a eficácia desse tratamento (SECRETARIA DE SAÚDE DE 

MATO GROSSO DO SUL, 2011). 

Algumas tecnologias podem ser extremamente úteis na tomada de decisões na 

área da saúde. Uma dessas tecnologias é a rede bayesiana, que tem como um dos 

exemplos a capacidade de auxiliar, ainda durante a triagem, na melhor escolha do 

tipo de acesso vascular do paciente com insuficiência renal grave, entre outras 

situações.   

          As técnicas Bayesianas, além de serem amplamente utilizadas dentro da área 

de Estatística, são também utilizadas em outros enredos. Um deles é o da Inteligência 

Artificial, uma área que pode ser denominada Inteligência Artificial Probabilística 

(ARA-SOUZA, 2021). 

         Através desta inteligência artificial será possível então estabelecer uma relação 

de probabilidade condicional entre variáveis pertencentes aos pacientes alvo. 

         O benefício mais relevante do pensamento probabilístico em relação ao 

pensamento lógico é a possibilidade de executar decisões sensatas mesmo na 

ausência de informações suficientes que garantam que uma ação será bem-sucedida 

(RUSSEL, 2003). 

        A justificativa deste trabalho é de que tal análise, utilizando-se das redes 

bayesianas, é de grande valia para o grupo pertencente ao estudo, visto a 

oportunidade de identificar a evolução da insuficiência renal e consequentemente 

promover a redução no número de óbitos. E também é de grande proveito para os 

profissionais da saúde, auxiliando no Suporte à Decisão Clínica (SDC). 
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2 OBJETIVO 

 

Analisar as possíveis relações de causalidade, utilizando inferências 

probabilísticas, entre os fatores relacionados para estipular as principais causas de 

óbito em pacientes com insuficiência renal grave. 

 

2.1 OBJETIVOS ESPECÍFICOS 

• Elaboração das redes bayesianas; 

• Determinar a viabilidade dos resultados obtidos. 
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3 REVISÃO DA LITERATURA 

 

3.1 INSUFICIÊNCIA RENAL 

 

3.1.2 Definição 

 

Insuficiência renal é a condição na qual os rins não conseguem realizar suas 

funções básicas. A insuficiência renal pode ser aguda (IRA), quando a função renal é 

perdida subitamente e rapidamente, ou crônica (IRC), quando esta perda é devagar, 

com progressão e não reversível (MINISTÉRIO DA SAÚDE, 2011). 

Além de purificar o corpo de resíduos e fluidos, os rins desempenham outras 

funções cruciais, como regularem a quantidade de H₂O e outras substâncias químicas 

no sangue, como fósforo, sódio, cálcio e potássio. Eles também filtram medicamentos 

e toxinas do corpo e secretam hormônios no sangue. Esses hormônios controlam a 

pressão arterial, estimulam a produção de células vermelhas do sangue e fortalecem 

os ossos (MINISTÉRIO DA SAÚDE, 2011). 

 

3.1.3 Principais tipos de tratamentos 

 

Pacientes que possuem insuficiência renal aguda ou crônica, dispostas na 

forma grave, necessitam frequentar centros que ofereçam serviços de hemodiálise. 

Tal procedimento consiste na execução, de modo artificial, das funções dos rins.  

A máquina de hemodiálise acessa o sangue do paciente através de um cateter 

ou fístula arteriovenosa e, então, usa uma bomba para enviá-lo até o dialisador. No 

dialisador, o sangue é submetido à solução de diálise através de uma membrana semi-

permeável, que elimina o excesso de líquido e toxinas, e devolve o sangue puro ao 

paciente por meio do mesmo acesso vascular (SBN, 2021).  
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Figura 1 – Hemodiálise 

 

 

 

 

 

 

 

 

 

Fonte: Sociedade Brasileira de Nefrologia, 2021. Disponível em <https://www.sbn.org.br/orientacoes-

e-tratamentos/tratamentos/hemodialise/>. Acesso em: 12 de Maio de 2022. 

 

Outra opção de tratamento para pacientes com insuficiência renal é a diálise 

peritoneal, que é uma técnica que utiliza o peritônio, um filtro natural presente no 

corpo, para substituir a função dos rins. O peritônio é uma membrana semipermeável 

que envolve os órgãos abdominais, a área que sobra entre esses órgãos é 

denominada de cavidade peritoneal. Nessa técnica, um líquido de diálise é inserido 

na cavidade através de um cateter flexível, depois é drenado após um determinado 

tempo. A diálise peritoneal acontece diretamente no corpo do paciente (SBN, 2022). 

 

Figura 2 – Diálise Peritoneal 

 

 

 

 

 

 

 

 

 

Fonte: Sociedade Brasileira de Nefrologia, 2021. Disponível em < https://www.sbn.org.br/orientacoes-

e-tratamentos/tratamentos/dialise-peritoneal/>. Acesso em: 12 de Maio de 2022. 
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3.2 REDES BAYESIANAS 

 

Os métodos de raciocínio probabilístico são eficientes em situações onde há 

informações incompletas ou aproximadas, ou seja, em ambientes incertos. Nesses 

casos, é possível aplicar teorias como a Teoria Bayesiana da Probabilidade, que vê a 

probabilidade como o grau de confiança no acontecimento deum evento 

(GONÇALVES, 2008). 

De acordo com Marques; Dutra (2008) 

Uma Rede Bayesiana consiste do seguinte: um conjunto de variáveis e um 

conjunto de arcos ligando as variáveis; cada variável possui um número 

limitado de estados mutuamente exclusivos; as variáveis e arcos formam um 

grafo dirigido e sem ciclos.  

 

Redes Bayesianas utilizam a Teoria de Grafos para representar as variáveis e 

suas relações. As variáveis são representadas por nós e as relações são indicadas 

por arcos, criando um gráfico dirigido e livre de ciclos, conforme ilustrado na figura 3. 

Neste exemplo, a variável Z está relacionada às variáveis X e Y (GONÇALVES, 2008). 

 

Figura 3 – Grafo modelo de redes bayesianas 

 

 

 

 

 

 

Fonte: GONÇALVES, 2008. Disponível em <https://andreric.github.io/files/pdfs/bayesianas.pdf/>. 

Acesso em: 28 de Novembro de 2022. 

 

 

Estes tipos de redes usam o Teorema de Bayes para calcular a probabilidade 

de certos eventos com alguma informação disponível (STROSKI, 2018). 
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Segundo Yoshida (2007) 

O aprendizado em redes Bayesianas (a partir de dados) pode ser visto como 

um processo que gera uma representação interna (na máquina) das 

restrições que definem um dado problema de modo a facilitar a recuperação 

dos dados, gerando assim um menor esforço computacional para essa 

representação. Este processo deve: aprender a estrutura da rede, ou seja, 

identificar as relações de interdependência dadas pelos arcos, e aprender as 

distribuições de probabilidades (parâmetros numéricos) com base na 

estrutura já definida. Por isso é, normalmente, dividido em dois subprocessos: 

aprendizado da estrutura e aprendizado dos parâmetros numéricos. 

 

A propagação de evidências em Redes Bayesianas envolve estabelecer um 

processo que, aproveitando a conexão da rede, determine as distribuições de 

probabilidades das variáveis objetivo, sejam elas para diagnóstico ou prognóstico, 

levando em conta os valores das variáveis que representam evidências observadas. 

A propagação é uma ferramenta que permite avaliar as probabilidades futuras das 

variáveis da rede. Para preservar a coerencia na crença sobre as variáveis do modelo, 

sempre que uma nova evidência surge em favor de uma variável, a crença nesta 

variável é atualizada e essa nova crença é transmitida por toda a rede. Dessa forma, 

toda a rede atualiza sua crença e os efeitos da nova evidência são incorporados por 

todas as variáveis, mantendo a representação coerente (PLENTZ, 2003). 

 

3.3 AVALIAÇÃO LABORATORIAL 

 

3.3.1 Ureia  

 

A ureia é uma substância produzida no fígado e eliminada através da urina e 

do suor, com o auxílio dos rins. Contudo, se houver problemas de funcionamento dos 

rins, a ureia não será eliminada corretamente e sua quantidade no sangue pode 

aumentar, o que é prejudicial para o organismo e é conhecido como uremia. Os 

valores considerados normais para a ureia podem variar de acordo com o método de 

análise, mas normalmente são os seguintes: crianças menores de 1 ano entre 9mg/dL 

e 40mg/dL, crianças acima de 1 ano entre 11mg/dL e 38mg/dL, e adultos entre 

13mg/dL e 43mg/dL (NEFROCLÍNICAS, 2021). 
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3.3.2 Creatinina  

 

A creatinina é uma substância relacionada ao funcionamento dos rins e 

encontrada no sangue. É produzida a partir da fosfocreatina, uma proteína obtida 

através da alimentação e da digestão pelo fígado, estômago e pâncreas. A 

fosfocreatina fornece energia aos músculos para suas atividades diárias, e a 

creatinina é transportada pelo sangue até os rins, onde é eliminada pela urina. O nível 

de creatinina no sangue indica se os rins estão funcionando corretamente. Valores 

elevados significam que os rins não estão eliminando a creatinina adequadamente, o 

que pode indicar doença renal crônica. Os valores considerados normais estão entre 

0,6 mg/dL e 1,2 mg/dL, mas podem variar com a idade, sexo e laboratório de análise. 

Recém-nascidos, por exemplo, têm referências de 0,60 a 1,30 mg/dL, enquanto 

mulheres têm de 0,60 a 1,12 mg/dL e homens de 0,70 a 1,3 mg/dL (NEFROCLÍNICAS, 

2022). 

 

3.3.3 Potássio  

 

Apesar do potássio ser muito importante para o bom funcionamento do nosso 

corpo por atuar diretamente para o desempenho correto do sistema nervoso, cardíaco, 

muscular e manter o equilíbrio do pH no sangue, tanto o excesso quanto a falta desse 

nutriente podem causar algumas complicações em nosso organismo. O excesso deste 

mineral no sangue é chamado de hipercalemia ou hiperpotassemia. Os sinais de 

excesso de potássio incluem redução dos batimentos cardíacos, palpitações, fraqueza 

muscular, dormências e vômitos. Já quando nível excedente é leve, geralmente não 

provoca nenhum sintoma. A presença excessiva de potássio no corpo pode ser 

decorrente de uma série de fatores, incluindo insuficiência renal, diabetes tipo 1, uso 

prolongado de diuréticos ou sangramentos. Em pacientes renais, a hipercalemia se 

torna mais severa. Por conta da insuficiência renal, o rim afetado reduz a prática de 

executar esse papel, e por consequência, causa o acúmulo do potássio no sangue. 

Por conta disso, todo paciente com doença renal crônica deve ter cuidados para 

manter a quantidade de potássio no sangue dentro da normalidade, ou seja, entre 3,5 

e 5,5 mEq/L (NEFROCLÍNICAS, 2023). 
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3.3.4 Cálcio  

 

A doença renal crônica favorece o chamado Distúrbio Mineral e Ósseo. Neste 

contexto, a produção de vitamina D cai e o fósforo se acumula no organismo, o que 

reduz a quantidade de cálcio na corrente sanguínea. O equilíbrio entre esses três 

nutrientes é fundamental para garantir a boa formação do tecido ósseo. A carência de 

determinadas substâncias favorece problemas como a osteoporose, podendo levar à 

ocorrência de fraturas; já o excesso causa problemas diversos, dependendo da 

substância. No caso do cálcio, existe o risco de calcificação dos vasos sanguíneos e 

outros tecidos.  O Distúrbio Mineral e Ósseo em decorrência da doença renal crônica 

pode ser identificado mesmo no período pré-diálise, ou seja, quando o paciente ainda 

não precisa recorrer a métodos artificiais para filtragem do sangue. Os níveis normais 

de cálcio no sangue variam de 8,8 a 10,4 mg/dL (2,20 a 2,60 mmol/L) (CHOCAIR, 

2021). 

 

3.3.5 Fósforo 

 

A molécula de fosfato é uma estrutura inorgânica formada por um núcleo de 

fósforo e quatro átomos de oxigênio. A quantidade de fósforo presente no corpo 

humano é regulada pelo nível de fósforo inorgânico (P) no sangue. Do total de fósforo 

corporal, que pode variar de 500 a 800g, 85% se encontra no esqueleto, 14% em 

tecidos moles, e o resto está distribuído pelo resto do corpo e no espaço extracelular. 

O rim é responsável por controlar a homeostase do fosfato e garantir a excreção renal 

adequada. Em condições normais, a excreção de fosfato pelos rins é igual à 

quantidade absorvida pelo trato gastrointestinal. A reabsorção renal de fosfato, que 

pode chegar a 80%, ocorre principalmente no túbulo proximal na borda da escova 

luminal, com o restante sendo reabsorvido nos túbulos distais ou eliminado na urina. 

O PTH aumenta a excreção de fosfato, enquanto baixos níveis de fósforo sérico 

estimulam os co-transportadores Na Pi renais para aumentar a excreção de fosfato. 

A hiperfosfatemia é diagnosticada quando o nível de fósforo sérico está acima de 

5mg/dL. Em crianças, a faixa normal é de até 6mg/dL, enquanto em bebês, níveis de 

até 7,4mg/dL são considerados normais. O nível de fósforo sérico costuma variar 

durante o dia, com níveis mais baixos no final da manhã e níveis mais elevados nas 
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primeiras horas da manhã. A hiperfosfatemia pode ser causada por uma redução na 

excreção renal de fosfato ou um aumento na carga de fosfato exógeno (BRANDÃO 

NETO, 2020). 

 

3.3.6 Fosfatase alcalina 

 

A fosfatase alcalina é encontrada em quase todos os tecidos do corpo, 

especialmente nas membranas celulares. Está presente em altos níveis no epitélio 

intersticial, túbulos renais, ossos, fígado e placenta. A enzima está envolvida no 

transporte de lipídios no intestino e na formação óssea. Os níveis aumentam por 

motivos fisiológicos ou devido a problemas no fígado ou nos ossos. Aumentos 

fisiológicos incluem a fosfatase alcalina placentária durante o segundo trimestre de 

gravidez, fosfatase alcalina óssea em crianças em crescimento e após as refeições 

em indivíduos com grupos sanguíneos B e O. A doença hepática é a causa mais 

comum de níveis elevados de fosfatase alcalina, mas também podem ser encontrados 

em problemas ósseos como osteomalacia, tumores ósseos e fraturas em cura. Níveis 

reduzidos são observados em condições como hipofosfatasia, hipoparatiroidismo e 

má nutrição. Os limites padrão da análise da fosfatase alcalina mudam conforme a 

idade: para crianças e adolescentes, abaixo de 2 anos: 85-235 U/L; de 2 a 8 anos: 65-

210 U/L; de 9 a 15 anos: 60-300 U/L; de 16 a 21 anos: 30-200 U/L; e para adultos: 46-

120 U/L (SANTA LÚCIA LABORATÓRIO, 2023). 

 

3.3.7 Glicose 

 

A diabetes é uma condição médica caracterizada por níveis elevados de açúcar 

no sangue. Isso é causado por uma falta de produção de insulina, o hormônio 

responsável por controlar a glicose no sangue, ou por uma má absorção da insulina. 

A diabetes pode causar sérios danos a nossa saúde, tais como o aumento da glicemia 

e as altas taxas que ocasionam complicações cardiovasculares, nos olhos, nos nervos 

e nos rins. A falta do tratamento e cuidado adequado pode acarretar casos mais 

graves e consequentemente levar à morte. A diabetes tem grande relação com o 

surgimento e progressão da doença renal crônica, pois pode danificar os néfrons 

(região estrutural responsável pelo funcionamento dos rins) e se a situação 

prevalecer, poderá ocorrer lesões definitivas na filtração renal. Quando o diabetes 
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ataca os rins, ocorre a chamada nefropatia diabética. Esta complicação, além de 

afetar diretamente os vasos sanguíneos, é capaz de levar a perda de proteínas da 

urina, causando a redução da função renal. Os níveis aceitáveis de glicose no sangue 

em jejum, variam de 70 mg/dL a 99 mg/dL (NEFROCLÍNICAS, 2022). 

4 METODOLOGIA 

 

 Este presente estudo somente foi desenvolvido após avaliação e liberação pelo 

Comitê de Ética em Pesquisa sob o Parecer Consubstanciado de número 5.477.327 

(ANEXO A). 

A pesquisa foi realizada no setor de hemodiálise do hospital Santa Casa de 

Misericórdia da cidade de Fernandópolis-SP. Trata-se de um estudo retrospectivo 

transversal de caráter qualitativo e quantitativo, com análise de prontuário e variáveis 

(através do sistema Wareline Conect-w) de pacientes acometidos por insuficiência 

renal aguda ou crônica graves, e que dependam de hemodiálise ou diálise peritoneal. 

           Foram feitas as análises das variáveis como: sexo, idade, tipo de doença renal, 

sorologia hiv e hepatite B, tabagismo, tipo de acesso vascular, plano de saúde, tempo 

de diálise, tipo de diálise, causa da insuficiência renal, causa do óbito, glicose, uréia, 

uréia após diálise, transaminase glutâmico pirúvica, potássio, cálcio, fósforo, 

paratormônio de molécula intacta, creatinina, glicose e fosfatase alcalina.  

 Como critério de inclusão foram considerados pacientes de ambos os gêneros, 

de todas as faixas etárias, com insuficiência renal aguda ou crônica e que façam 

hemodiálise ou diálise peritoneal. 

 Como critério de exclusão, não foram considerados para análise pacientes que 

fizeram cirurgia de transplante renal durante o período do estudo e pacientes que se 

recusaram a participar da pesquisa. 

A elaboração da rede bayesiana foi feita utilizando o software GeNIe 2.0, 

versão 2.0.5079.0, desenvolvido pela Decision Systems Laboratory, University  of 

Pittsburgh.  
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Figura 4 – Tela inicial GeNIe 2.0 

 

 

 

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 

 

Inicialmente, com o auxílio dos profissionais da saúde do setor de hemodiálise 

do Hospital Santa Casa de Misericórdia de Fernandópolis-SP, foi elaborada a rede 

contendo todas as variáveis, dispostas de modo que estabeleçam uma relação de 

causa e efeito, onde o ponto de partida da seta indica a causa e ponto de chegada da 

seta indica o efeito.  

Figura 5 – Rede bayesiana 

 

 

 

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 
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Os dados dos prontuários dos pacientes foram coletados através do sistema 

Wareline Conect-w, armazenados organizadamente numa tabela do Excel e salvos 

no formato “.csv”. As variáveis ureia, glicose, fosfatase alcalina, cálcio, creatinina, 

fósforo e potássio foram categorizadas conforme os valores de referência mostrados 

na seção 3.3 em aumentado, normal e diminuído.  

Figura 6 – Tabela excel 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do Excel 

 

Posteriormente a tabela foi importada para o GeNIe 2.0 através do seguinte 

caminho: File > Open Data File > Seleção da tabela no formato “.csv” > Abrir. Deste 

modo o software importa ordenadamente todos os dados da tabela.  

Figura 7 – Tabela importada para o GeNIe 2.0 

 

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 
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Em seguida é necessário executar um comando para que a rede faça a leitura 

dos dados inseridos e aprenda a definir as probabilidades. Para isso o seguinte 

caminho deve ser seguido: Data > Learn Parameters > Ok. Após feito isso, uma janela 

será aberta (conforme a ilustração abaixo). Deixe a caixa “Randomize initial 

parameters” selecionada, Defina o “Random seed” para “1”, Defina “Confidence” para 

“1”. E deixe as caixas “Uniformize” e “Enable relevance” desmarcadas. E clique em 

“OK” para finalizar.  

Figura 8 – Janela de leitura dos parâmetros de aprendizagem  

 

 

 

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 
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 Após finalizar a leitura o software irá exibir uma mensagem que a ação foi 

concluída, basta então clicar em “Close”. 

Figura 9 – Leitura dos parâmetros 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 

 

A rede foi então alimentada com uma amostragem contendo diversas variáveis 

de um “n” de 121 pacientes. A partir disso já é possível efetuar a propagação de 

evidências. Basta clicar em “Update”, ícone representado por um raio de cor amarela 

na barra superior. 

Figura 10 – Propagação das evidências 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 
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5 RESULTADOS E DISCUSSÃO 

 

Após efetuar a propagação das evidências podemos visualizar o percentual 

geral dos dados coletados referente à todas as variáveis. 

Figura 11 – Percentual geral dos dados coletados 

 

  

 

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 

 

A Figura 11 nos fornece dados percentuais quanto aos pacientes de modo 

geral. Onde é possível identificar uma predominância de insuficiência renal do tipo 

crônica (92% dos pacientes), com predomínio do sexo masculino (65%), sendo a 

maioria com acesso vascular tipo fístula arteriovenosa (67%), a patologia diabetes 

como causa principal da insuficiência renal (22%) e a grande massa pertencentes ao 

Sistema Único de Saúde (SUS) (90%), ou seja, que não possuem plano de saúde 

particular. 

Posteriormente, foi possível traçar através das redes a propagação das 

evidências propriamente ditas. Onde determinou-se as probabilidades das variáveis a 

partir das evidências previamente selecionadas. 
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Figura 12 – Seleção da evidência “acesso vascular - fístula” 

 

  

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 

 

 

Figura 13 – Seleção da evidência “acesso vascular - cateter” 

 

  

 

 

 

 

 

 

 

 

 
Fonte: Elaborado pelo autor por meio do software GeNie 2.0 

 

A partir das evidências selecionadas nas Figuras 12 e 13 é possível chegar à 

hipótese probabilística de que o uso de fístula arteriovenosa como acesso vascular, 

impacta grandemente na causa do óbito. Sendo o número de pacientes “não óbito”, 

ou seja, que não evoluem para óbito, é de  67%. Já quando utilizado o cateter venoso 
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como acesso vascular, o número de pacientes “não óbito”, que não evoluem para 

óbito, cai significantemente para apenas 38%.  

Figura 14 – Seleção da evidência “fumante - sim” 

 

  

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 

 

Figura 15 – Seleção da evidência “fumante - não” 

 

 

 

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 

 

Através das Figuras 14 e 15 é possível chegar à hipótese probabilística de que 

o fato do paciente NÃO ser fumante, também impacta grandemente na quantidade de 

óbitos. Sendo o número de pacientes “não óbito”, ou seja, que não evoluem para óbito, 
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é de  64%. Já quando o paciente É fumante, o número de “não óbito”, que não evoluem 

para óbito, cai significantemente para apenas 35%. Ou seja, o uso do cigarro é um 

grande fator de risco. 

Figura 16 – Seleção das evidências “fumante - sim” e “causa da IR – diabetes” 

 

  

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 

 

Figura 17 – Seleção das evidências “fumante - não” e “causa da IR – diabetes” 

 

  

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 

 

A partir das evidências selecionadas nas Figuras 16 e 17 é possível chegar à 

hipótese probabilística de que pacientes diabéticos que NÃO são fumantes, impacta 
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grandemente no número de óbitos. Sendo o número de pacientes “não óbito”, ou seja, 

que não evoluem para óbito, é de  82%. Já quando analisados os pacientes diabéticos 

mas que SÃO fumantes, o número de pacientes “não óbito”, que não evoluem para 

óbito, cai significantemente para apenas 53%. O uso do cigarro, tanto analisado 

sozinho, quanto em conjunto com outras comorbidades, demonstra ter enorme 

potencial de risco para os pacientes com insuficiência renal. 

Figura 18 – Seleção das evidências “fumante - sim” e “acesso vascular - fístula” 

 

  

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 

 

Figura 19 – Seleção das evidências “fumante - sim” e “acesso vascular - cateter” 

 

  

 

 

 

 

 

 

 

 

 

Fonte: Elaborado pelo autor por meio do software GeNie 2.0 
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Através das Figuras 18 e 19 é possível chegar à hipótese probabilística de que 

o fato do paciente SER fumante associado ao uso do acesso vascular tipo fístula, 

chegamos ao número de pacientes “não óbito”, ou seja, que não evoluem para óbito, 

de  41%. Já quando o paciente também É fumante mas associado ao uso do acesso 

vascular tipo cateter, o número de “não óbito”, que não evoluem para óbito, cai 

significantemente para apenas 23%. Ou seja, o uso do cigarro é um grande fator de 

risco. Entre o grupo dos fumantes, o tipo de acesso vascular pode potencializar ou 

diminuir as chances desse paciente vir à óbito, ficando claro que o uso do cigarro 

somado ao tipo de acesso vascular cateter aumentam os riscos do paciente. 

A partir da metodologia proposta foi possível identificar algumas 

potencialidades e falhas relacionadas aos pacientes com insuficiência renal. O “n” 

utilizado para a pesquisa foi uma das limitações do método utilizado. Pesquisas 

posteriores podem levar em consideração não apenas um centro de hemodiálise 

regional, mas vários centros de hemodiálise de regiões diferentes do país, 

aumentando ainda mais a confiabilidade das probabilidades das redes. 
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6 CONCLUSÃO 

 

 Foi possível utilizar as redes bayesianas para analisar as prováveis relações 

causais entre as variáveis avaliadas de pacientes com insuficiência renal grave. Por 

meio de inferências com as redes viabilizou-se sua utilização no auxílio às ações na 

área da saúde voltadas aos pacientes. De modo geral espera-se contribuir 

significativamente com os centros de hemodiálise, pacientes com insuficiência renal e 

profissionais da área da nefrologia. E apesar do uso de inteligência artificial ser um 

artifício ainda relativamente novo na saúde, a intenção é que cada vez mais possa 

auxiliar no Suporte à Decisão Clínica e no impacto na qualidade de vida dos usuários.  
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ANEXO A – Parecer consubstanciado do Comitê de Ética e Pesquisa 
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